Prind Shop

AUTOMATICALLY DESIGNS & PRINTS GREETING CARCS, STATIONERY & BANNERS.

Macintosh 1.3.2

This enhanced version of The Print Shop now ships on one 800K disk, is MultiFinder compatible and works with
the following computers: Macintosh Plus, SE, SE/30, Classic, LC and |l series. It is compatible with the
following printers: ImageWriter |, Il and LQ and the LaserWriter, LaserWriter Plus, LaserWriter ISC, IINT and
IINTX. The Print Shop disk no longer includes a System Folder but will work with System 4.1 or later.

For your convenience, we have removed all copy protection from this version of The Print Shop, You may make
a backup copy of The Print Shop provided that such a copy is an essential step in the utilization of The Print Shop
with your own computer and that it is used in no other manner. A copy may also be made for archival purposes
provided that all archival coples are destroyed in the event that continued possession of the Print Shop should
cease o be rightful. All other copying and distribution is strictly prohibited.

To make a backup copy of the program, or to install it on your hard disk, follow the instructions outlined on page

four (4) of your Print Shop manual. The Print Shop will now run from a copy of the program without prompting
you 1o insert the master disk.
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Priit Shop

Macintosh Reference Card

For quick reference this card shows all the fonts, barders, and graphic designs (small large and full panel) included in
The Print Shop program, Also shown are a bonus set of graphics which are stored In a MacPaint file

Fonts: (Reduced from actual size)
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Graphics

The following graphics may be selected by using the procedure detailled in Section 3 of the manual

Small: (56)

]

LO

CONFIDENTIAL

Large: (101)






65

64

82

61

rr

-~

o

- 2 -"-vai‘:

Lok

: g
.ﬁ..I: ml- P L
shenny Senus Yhews ¥ ow
puen, twwy P00t uey
Lot "B el |
weswnr w0 * Y wamen 1
mLt -

10

100

?u?u..(\.?_‘?.*
< (€ (€ (< (<
| VR PR AR PA R Y
N ~ N N I
A.~ NA.—. { Aw NA“ (AAHN
WU
Ny 2 N1 N N
XCXCXC G
™A A A
g T N2 N N

r_.,_...AA <




Full Pane!. 18] /

.
(¥}

(T

) Bonus Graphics:
. F‘J -'n" ' .“W' The following graphics are stored as a MacPaint

‘—'{f gocument on The Print Shop disk. They may be

gcted by using the procedure dascribad in 1t

\1;J’| o

— A -~ M . 8 .
-From MacPal action of the manual

—— o "{{
@
11 F



Borders:

The following borders may be selectad by using the procedure datailed
in Saction 4 of the manual
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INTRODUCTION

USING THIS MANUAL

Your Macintosh + The Print Shop = a stationery store in
your own home.

The Print Shop is the program Macintosh users have been waiting for! It
helps you fully utilize all the graphic capabilities of the Macintosh to quickly
and easily design and print out your own:

Greeting Cards

Invitations and Announcements
Stationery and Letterhead
Banners

Signs

...and much more!

Designs that would require hours of time-consuming cutting and pasting
without The Print Shop take just minutes to design and print with The Print
Shop.

The Print Shop is so easy to use you'll be printing out designs in minutes.
Simply make your choices from the menus and windows on your screen. Pick
out a ready-made design or create your own. Choose graphics from a wide
selection provided with the program or use art from any MacPaint file. Add
your own drawings, images from graphics collections, digitized graphics, etc.
Your choices are just about unlimited.

You can brighten your projects by using colored paper and color ribbons.
And, with the ImageWriter |, you can even print projects with multicolored
designs.

The Print Shop has been especially designed to take advantage of the
Macintosh format. You can type your message, pick a border, or add a graphic
at any time you want. You can design and redesign with a click of the mouse
and experiment until your project is just the way you want it.

This manual will introduce you to The Print Shop's capabilities and help
you learn how to use all the different features The Print Shop has to offer.
Use it as a guide to answer any questions that may arise as you work on your
projects.

Read the Getting Ready section of the manual if you want a brief
refresher of Macintosh terms and operations. This section also discusses
making backup copies.

A Quick Start will help you begin quickly by giving you an overview of
all the important features to be found on the four Main Project screens and on
the Menu Bar.

The Graphics Menu reviews all the graphics options you may want to
use in your project. The options—graphic selection, editing, layout,
etc.—work the same way in all The Print Shop projects (greeting cards, signs,
letterhead, and banners) so you'll use the Graphics Menu to choose and
design graphics for whatever you create. All the graphics features are
discussed in this section. If you have any questions about graphics or get
stuck at any point, look to this section for help. It will guide you through the
process of choosing art from The Print Shop Graphics collection, as well as
from MacPaint files, of editing the graphics to suit your needs, and of laying
out the artwork in your design.



For specific help on any project, turn to the project sections—Greeting
Card and Sign, Banner, or Letterhead.

When you are ready to print, Printing Your Project will give you
directions on checking paper alignment, selecting color printing, and printing
with the ImageWriter or LaserWriter.

Finally, Special Features gives special tips and suggests additional
options to help you get the most out of The Print Shop.



1.

GETTING READY

THE PRINT SHOP INCLUDES

WHAT YOU WILL NEED

MAKING A BACKUP COPY

STARTING THE PROGRAM

One Print Shop program disk

The Print Shop manual

Quick Reference Card

Colored pinfeed paper and envelopes

. - . .

Required:
« 1MB Macintosh, Macintosh Plus, or Macintosh SE, SE30, II, IIX, lICX
« Printer (ImageWriter | or Il, LaserWriter or any 100% compatible printer)

Optional:
+ External disk drive
+ Colored ribbon for the ImageWriter I

Note: If any of the Macintosh terms used in the following paragraph:
are unfamiliar to you, see Reviewing Macintosh Terms, page 6, for a brie
review of their definitions.

Itis a good idea to make a backup copy of your Print Shop disk and use
your copy rather than the original while working with the program. You can
make a backup copy the same way you make copies of MacWrite or MacPain
Simply:

1. Insert your original Print Shop disk into your Macintosh.

2. Once it has loaded and the disk icon has appeared on the desktop,
insert the disk you wish to use as a backup. If it is an unformatted disk, follow
the on-screen prompts to format and name your disk.

3. Drag the icon of The Print Shop disk across the desktop until it covers
the icon of your backup disk. A dialog box will appear verifying that you wish tc
replace the contents of the backup disk. If this is correct, click OK. When the
backup disk is complete, you can name the backup disk and use it instead of
the original.

4. Store the original Print Shop disk in a safe and convenient place.

If your computer is off: Turn your computer on, insert the Print Shop pro-
gram disk into the internal drive.

If your computer is on: Eject any disks currently in the drive. Turn the powe
off and then on again. Insert the Print Shop program disk in the internal drive.



Your Desktop Here is what your desktop will look like when you open Print Shop 1 for
the first time. The Print Shop program icon and System Folder will appear.

% File Edit Diew Special

The Print Shop ===

The Print Shop—double-click this icon to S91K ndisk 189K available
start The Print Shop program.
TM‘Pri-ﬂ'SMD PS Graphics PS Borders
PS Graphics—contains all the graphics e
provided with The Print Shop program. E]
PS Fonts  Ready-made Folder
]

A MacPaint File—contains some MacPaint
graphics you can use with The Print Shop.

PS Fonts—contains all the fonts provided PS Borders—contains all the borders
with The Print Shop program. provided with The Print Shop program.

Ready-made Folder—contains pre-designed
cards, banners, signs and letterheads.



REVIEWING MACINTOSH
TERMS

If you've been using other Macintosh programs, The Print Shop's
operation should seem familiar to you. Here's a brief review of some
Macintosh terms and features you'll use with The Print Shop:

& File Edit Selections Graphics Fonts FontSize

Menu Bar
Pointer — ||
1 [~ ( Borders | [ Ready-made )
Scroll Bar / E _P,'u,lr_., I D — “
[] Bota [ extiine
—-—— O reatic [ chadan
Buttons —— i
Spacing Al ignment
=
=] =]
. =
Pointer The small black arrow you use to "point” at things on the screen. You

Mouse Operation

Buttons

Menu Bar

move the pointer by moving your mouse on your desk or pad.

1. Clicking: Clicking is used to select items that appear on the screen. To
click, position the pointer over the item you want, then press and quickly
release the mouse button.

2. Pressing: Pressing and holding the mouse button causes a
continuous action. To press, position the pointer where you want it, then
hold the mouse button down. For example, press the arrows at the top or
bottom of the scroll bar to scroll.

3. Dragging: Move items from one place to another on the screen by
"dragging" them. To do this, position the pointer over the item you want to
move, then press the mouse button. Holding the button down, "drag” the
item to its new location by moving the mouse across your desktop. When the
item has moved to where you want it, release the mouse button.

4. Highlighting: Select text for editing functions by "highlighting" it. To
highlight text, position the pointer to the left of the text to be highlighted,
press the mouse button and drag the pointer over the text.

Circles or rectangles with labels in them. When you want to perform the
action or select the item described by the label, click the button with the
mouse. Buttons and menu items that are grayed-out cannot be used.

The white strip across the top of your screen. The title of each menu is
written on the menu bar. You choose from a menu by positioning the pointer
on the menu title, pressing the mouse button, then dragging to the
command you want and releasing.



Dialog Boxes

Scroll Bars

Creating and Editing Text

In many cases, when you select an item, a dialog box will appear on the
screen. In some dialog boxes, you click buttons to change or confirm
choices; other boxes simply provide information. When you have finished
making selections in a dialog box, click "OK" to signal that you are done. Click
"Cancel" to return to where you were without taking any action.

Scroll bars let you view all the contents of a window when those contents
are too long to fit on the screen. Arrows are located at the ends of a scroll bar.
The area between the arrows represents the full window. You can view
different areas of the window by scrolling.

1. To scroll slowly, click one of the arrows.
2. To scroll continuously, press one of the arrows.

3. To scroll more quickly, click the area between the arrows or drag the
scroll box to a new position.

In general, you can type and edit text for your projects as you would using
MacWrite.

The text you type will appear at the blinking cursor on your screen.

1. To move the cursor within a line use the Backspace key and the space
bar.

2. Tostartanew line, press Return. To move up a line, press Backspace.

3. To erase text, simply move the cursor to the right of the text you wish
to delete. Then press Backspace. Or highlight all the text to be deleted and
press Backspace.

You can choose a typeface and typesize from the Font and FontSize
Menus and a typestyle from the typestyle boxes that will be available as you
work on your project. You can also choose the spacing and alignment of the
text.

Make all your type selections first, then begin typing and see how your
choices look. To make changes in the typeface, size, or style of
text you have already typed, first highlight the text to be
changed. Then make your new font and typestyle choices. The highlighted
text will change on the screen. When you are satisfied with your choices, click
the mouse to remove the highlight. Move your cursor to wherever you wish to
continue typing.

If you insert a word or words within previously typed text, the new word or
words will match the surrounding text. If you wish to use a different typestyle,
simply move your cursor to the place where you wish to make your insertion,
then make your new font and typestyle selections and begin typing.

If you erase text by mistake or simply want to cancel your last action,
select Undo from the Edit Menu before doing anything else.



A QUICK START

OPENING THE PRINT SHOP

Opening Your Project

THE MAIN PROJECT
SCREENS

GREETING CARD

Move up or down scroll bar to
see entire card panel.

Click to see front or inside of card. = ||
Click to add your own credit — 1

line to appear on card.

Click to choose a ready-made card. =1

Click on/off one or more —— ||

Click to choose a different border. — | 7/

boxes to choose typestyles.

This section will give you an overview of all the important features to be

found on the four Main Project screens and on the Menu Bar. Use it if you want
to get started quickly. Once you've worked on some projects and gained some

hands-on experience, you can come back to the manual for more information.

Load the Print Shop program disk following the directions given under

“Starting the Program’’ Select

'l on your desktop. Double-click on the icon

to open The Print Shop program. The Project Selection screen will appear.

Move the pointer to one of the four icons —Sign, Letterhead, Banner, or
Greeting Card. Double-click to begin working on the project of your choice.

& File Edit Selections Graphics Fonls FantSize

I EENEERERY!

Y o ER 1

]
1

e

/}_f‘i .

7

1113 T

- Greeting C

. =— Untitled

& File Edit Selections Graphics Fonts

FontSize

Greeting Card
@Froni
O Inside

I

| —— ([ Borders

] [ Ready-made |

& Prain [J Underline
{D Bold [ autl Ine
[ ttatic [ ohesian
sm cmg, m'Mt -
B2
= =
=l E

Click one box to choose
spacing of type lines.

Click one box to choose
alignment — left, center, right.



SlGN & File Edit Selections Graphics Fonts FontSize 1

cm————————— QN

Move up or down scroll bar to see entire sign. L Si gn
Click to choose a ready-made sign. —
et [ Borders | [_Ready-made )
Click to choose a different border. X Plain [ underiing
[[] Bota [ @l i
L-’// O rearic [ enaoden
-

Click on/off one or more boxes — | Spacing Al ignnant

to choose typestyles. =] 3]

e

e /=

Click one box to choose spacing of type lines. Click one box to choose type alignment—

left, center, right.

LETTERHEAD i & File Edit Selections Graphics Fonts FontSize =]
S Unlitled ===
l |

Letterhead
Click to see top or bottom Spacing Al ignment
letterhead panel. ————f——_ ® Top R Prain [ underline =
O Bottom
Click on/off one or more boxes [0 Bota [ Gutlina = E 3
to choose typestyles.
— O e [ cndes ==

Click to choose a ready-made letterhead. — |

Click one box to choose spacing of type lines. / Click one box to choose type alignment—
left, center, right.

BANNER & File Edit Selections Graphics Fonts FontSize

Banner Window —]

Move along scroll bar to
see entire banner. \
Your currently selected graphics—drag

one or more graphics and place
in the Banner Window. \

Click to see small or large graphics. — i Earie) [ Piain O] Undarline
" [ eo1d [ ewtl ine
. Ready-made — [ Shadew
Click to edit pixel shape and pattern / /
of text message. ; .
Click to choose a ready-made banner. Click on/off one or more boxes to
choose typestyles.
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THE MENU BAR

APPLE MENU

Key Caps

& File Edit Selections Graphics Fonts FontSizﬂ

You will go to the Main Menus to make selections that are common to all
Print Shop projects—for example, to print, to choose your graphics, to
preview or see the whole project as you are designing it.

mrlle Edit Selections Graphics Foals FantSize |
About The Print Shop...

Alarm Clock
Chooser
Control Panel
Key Caps
Scrapbook

This menu contains several common desk accessories. You may find
these particularly helpful with The Print Shop program; use them the same
way you would in any other program.

Lets you see the letters and symbols of your fonts. Select this accessory
from the Apple Menu as you design your project. A keyboard will appear on
screen, as well as an extra menu at the far right of the Menu Bar—this is the
Key Caps Menu.

& File Edit Selections bGraphics Foals FantSize Key Caps
Untitled

77

.
o
A0

O reatic

Spacing

Example: Cairo font

Select a font from the Key Caps Menu and the lower case letters/symbols
will appear on the keyboard. Press Caps Lock or Option to see the capital
letters/symbols available in the font you have selected.

You can type a few letters and see how they look in the space above the
keyboard.

You can use Key Caps to see the typestyle possibilities of any font. Itis
especially useful for locating particular characters in a graphics font, such as
Cairo.



Scrapbook

FILE MENU

New

Open

Close

Revert

Save

Save As...

Preferences

Select Colors

Print Options

Adjust Printer

Lets you get text and graphics from other programs to be used in your
Print Shop projects. You can also use the Scrapbook to store Print Shop
graphics for use in other programs.

| « JIICW Edit Selections Graphics Fonts FontSize |
New

Open...

Close

Revert

Save

Save fs...
Preferences...
Select Colors...
Print Bplions...
Adjust printer...
Print Sign...

Quit

Lets you start a new project of the same kind you have been working on.

If you have finished a sign, and want to design a new sign, select New.
Note: Selecting New will erase your previous design; if you
want to save your design, be sure to do so before selecting
New.

Lets you open a saved project file of the same kind. For example, if you
are working on a banner, select Open to open one of the banner files saved
on your disk.

Lets you close a project file. When you close a project file, the program
will return to the Project Selection screen.

Lets you return to the last saved version of the project.

Lets you save your design to an already named file. Note: Although
you can save your designs to The Print Shop disks, we
recommend that you save them to your own data disks.

Lets you set up and name a new file to save your design.

Lets you customize your loading procedure. See Section 8, Special
Features, for details.

Lets you select colors for each of your design elements before printing
with a color printer.

Lets you choose special layout features for greeting cards and banners.

Lets you test to make sure your paper is properly aligned so that your
projects will print out correctly.

11
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Print...

Quit

EDIT MENU

Undo

Cut

Copy

Paste

Clear

Select All

Show Clipboard

SELECTIONS MENU

Lets you print your project.

Lets you leave The Print Shop. If you've made changes in the current
project, you'll be given an opportunity to save the changes before quitting.

I & File Selections Graphics Fonts FontSize ]

tindo 52
Cut ¥H
Copy ®C
Paste ®U
Clear

Select All %A
Show Clipboard

Lets you undo your most recent typing. Use Undo for such things as
restoring text that has been deleted by mistake or cancelling your last
keystroke.

Lets you remove the current selection—usually highlighted text—and
place it on the Clipboard.

Lets you copy the current selection to the Clipboard.

Lets you add the contents of the Clipboard to your document at the
cursor. You can also use Paste to replace text on the screen with text in the
Clipboard. Highlight the text on the screen that you wish to replace before
selecting Paste.

Lets you clear the current selection. When you clear, the selection will
not be placed on the Clipboard.

Lets you select or highlight the entire text of your sign, greeting card or
letterhead panel. This enables you to quickly cut, copy, etc. the entire block
of text.

Shows the current contents of the Clipboard.

® File Edit Graphics Fonts FontSize |
vSign
Banner
Letterhead
Greeting Card

Preview...

You can go to this menu whenever you want to switch from one kind of
project to another. If you have been working on a sign, for example, and want
to switch to a greeting card, simply click Greeting Card.



Preview This feature lets you preview your full design—text, borders and
graphics—before you print it. Select Preview to see the full page of your
letterhead or sign, the front and inside of your greeting card, or your
complete banner.You can see how your design looks any time you want.
Select Preview before you add new elements—Ilarge graphics, new borders,
etc. Select Preview before you print your project to make sure you are
satisfied with your completed design.

GRAPHICS MENU [C€ File_edit_selections |EIETTNEM Fonts Fontsize ]

Select Graphics... *06
To-From Macpaint™ file... %M

To-From Clipboard...

Graphic Layout... *L
Graphic Editor... ®E
Save Graphics... xS
Delete Graphics... ®D

You will use this menu whenever you want to select, modify or lay out
graphics in your project. You'll find a full explanation of the Graphics Menu in
Section 3 of this manual.

FONTS AND FONTSIZE T TR TATEEIINTES o s B on's:-c —
vAthens 9 point

Cairo 10
Chicago 12
Courier

Geneva 14
Helvetica vi1®
London 20
Los Angeles 24
Monaco 30
New York

San Francisco 86
seattle 48
Times 12
Toronto

Uenice

These menus show the different fonts and type sizes you can use in your
projects. Select a font from the Fonts Menu. Then open the FontSize Menu
and choose the size you wish. The recommended sizes for the type you've
chosen appear in outlined numerals.

13



3. THE GRAPHICS MENU

Whatever Print Shop project you decide to make, you will probably want
to use graphics. You may want to add a birthday cake to your greeting card, or
one of your own MacPaint drawings to your banner, or a digitized photo to
give your letterhead a special touch.

The Print Shop allows you a great deal of freedom and creativity in
selecting, editing, and laying out graphics. You can make selections for all of
your projects quickly and easily by using the Graphics Menu.

The items in the Graphics Menu work in the same way for all of the
different Print Shop projects: Greeting Cards, Signs, Letterhead, and

Banners.
[ & rite edit_selections XXM Fonts Fontsize ]
Select Graphics... ®6
To-From Macpaint™ file... %M
To-From Clipboard...
Grophic Layout... %L
Graphic Editor... ®E
‘seve Graphics... s
Delete Graphics... ®D
Select Graphics Lets you pick a selection of small, large, and full panel graphics from The
Print Shop Graphics collection or other graphics library files to use in your
project.
To-From MacPaint File Lets you select graphics from any MacPaint file to use in your project.
To-From Clipboard Lets you select graphics from the Clipboard for use in your design.
Graphic Layout Lets you lay out your graphics on the project you are designing.
Graphic Editor Lets you modify small and large graphics before you use them in your
design.
Save Graphics Lets you save one of the currently selected graphics to a graphics library

file. It also lets you save a graphic you have modified with the Graphic Editor t
afile or lets you reorganize graphics into a different file.

Delete Graphics Lets you delete a graphic from a graphics library file.

You can use these options at any time and in any order you want, but
you'll probably find it easiest to select your graphics first, either from Select
Graphics or from a MacPaint file. Then you can use Graphic Layout to add the
graphic to your design or Graphic Editor to make changes before you place
the graphic in your design.

Save Graphics and Delete Graphics are features you will want to use to
create and revise your own personal graphics library files.
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SELECT GRAPHICS

Active Selection Box

Your Currently Selected Graphics

Scroll Bar

Large, Small, Full Panel

Full Panel Placement

& File Edit Selections

Fonts FontSize,
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QO smal
@ Large
(OFull Panel

Change file

The Print Shop Graphics collection has three different types of pictures
you can use—small, large, and full panel graphics. Click the button next to the
size graphics you wish to see.You can choose 4 large and 4 small graphics to
use in designing your current project. You can also choose full panel
illustrations for all projects except Banner.

The currently selected graphics appear at the top right. A dotted
rectangular box surrounds one of them. This is the Active Selection Box. To
select a new graphic to replace the one in the box, scroll through the graphics
in the large window. Click the one you want. The graphic you click will replace
the graphic inside the Active Selection Box. To replace another of the
currently selected graphics, first click the graphic you want to replace. The
graphic you click will be surrounded by the dotted box. Now, select a new
graphic from the large window just as before. You can replace any or all of
your currently selected graphics in this way.

Remember to move the dotted box to the graphic you wish to replace
before selecting a new graphic.

It's easy to pick all your graphics—small, large, and full panel—at one time.

All you have to do when you are finished making selections of one size is click
another size. The Print Shop graphics available in that size will appear in the
large window. You can then change any or all of the currently selected
graphics that appear at the top right.

Full panel graphics are available for greeting cards, signs, and letterhead.

When selecting full panel graphics for greeting cards, you can pick a
panel for both the front and the inside of your card.

« Click Front or Inside to indicate your choice.

When selecting full panel graphics for letterhead, you can pick a panel for
both the top and bottom of the page.

« Click Top or Bottom to indicate your choice.

15
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Finished Selecting Graphics?

Changing Graphic Files

TO-FROM MACPAINT FILE

Full Panel Graphic Selection Window for Greeting Card & Sign:
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Full Panel Graphic Selection Window for Letterhead:
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Once you are satisfied with all your graphic selections, click
to return to the Main Project screen and continue with your project.

To get graphics from the Print Shop Graphics file or from a graphics library
file you have created (see page 24 for instructions on how to save and
delete graphics), click . A dialog box will appear allowing you to
eject disks, select drive, insert a new disk containing graphics files, and open
afile. Your file will appear on screen and you can make selections from it.

Select To-From Macpaint file to copy graphics from any of your MacPaint
files to your small, large, and full panel graphics or to copy Print Shop graphics
to MacPaint files.

When a dialog box appears, you can eject a disk, insert another disk
containing graphics files, and open a file.
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After opening a new MacPaint file, use the scroll bars to move around in
the MacPaint file window.

« Click Small, Large or Full panel to choose the size of the graphics you
wish to add to or replace. Choose the size depending on the size of the
MacPaint graphic you wish to copy. Note that the size of the dotted capture
box in the large window changes as you switch from small to large to full panel
graphics.

One of your graphics will appear in the Active Selection Box. This graphic
will be replaced with any you select from your MacPaint file. If you wish to
replace another graphic, click on it. It will then appear in the Active Selection
Box.

COPYING FROM MACPAINT Drag the capture box to the part of the MacPaint file you want to copy.
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Click(<-cepy<- ). The graphic inside the capture box will replace the one in
the Active Selection Box.
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Centering the Image

Touching Up Your Image

Changing the Capture Box

Remember to Revert
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You can keep modifying this image by moving the rectangle and copying
the new image.

You can center or move the copied image in the Active Selection Box,
too. Move the pointer inside the box. The pointer becomes a Grabber hand
that allows you to drag the image around inside the box.

You may wish to erase part of the surrounding MacPaint file so you can
copy a clean image. If you press the Option key, the Grabber in the MacPaint
window will become an eraser that you can use to erase any part of the image
that you want. You can also erase in the Active Selection Box by moving your
pointer into the box and then pressing the Option key.

You can change the size of the capture box in order to copy a larger or
smaller portion of an image. To do this:

1. Click outside the capture box.

o2 Position the cross hair (+) at the upper right corner of the image you
wish to select.

3. Drag until the box captures the portion of the image you want. Then
release the mouse button.

4. Click (=copuc-).

Note: If you want to clear the captured portion of the image, press
Backspace; everything within the capture box will be cleared.

You may want to experiment with different sized or shaped capture boxes
to get an image you like. If the proportions of your capture box are very
different from the size of the original, your image may be somewhat distorted.
You can use this distortion to create various effects.

The Revert button can be a lifesaver! Click it to restore your active
selection to its original form. If you've made changes you don't like, choose
(Revert ],



Continue Making Selections

COPYING TO AMACPAINT FILE

The Copy Keys

TO-FROM CLIPBOARD

When you are satisfied with the graphic in the Active Selection Box, you
can continue adding graphics from your MacPaint file.

« Click another graphic. It will appear in the Active Selection Box. You can
then replace it with a graphic from the MacPaint file in the large window.

+ Click to view another MacPaint file.

) when you are ready to save the changes you've made
and continue with your design.

You can copy to a MacPaint file as well as copying from one. This is a
handy feature. It allows you to save graphics from The Print Shop to a
MacPaint file.

You might want to do this if:

1. You want to edit a graphic in MacPaint rather than in the Graphic Editor.

Note: This is the only way to edit full panel graphics.

2. You've changed a graphic and you'd like to keep it in a MacPaint file for
further use.

To copy the active selection to the MacPaint file window, click (=>copy-> .

To save your changes in the large window as a new file, click and
follow the directions in the dialog box.

You can save the graphic in the same size or modify it by stretching or
shrinking the capture box in the MacPaint file window.

If you should press the wrong Copy key, here's what you can do:

If you press by mistake:

1. Click (tesd J

2. Click No when the dialog box appears. DO NOT save the MacPaint file.

3. Reload your MacPaint file. No changes will have been made.

If you press by mistake:

1. Click (revert]. Your original graphic will appear in the ActiveSelection
Box. You can then continue making selections from your MacPaint file, if you
wish.

Select To-From Clipboard to copy any of the currently selected graphics
to the Clipboard or to copy the contents of the Clipboard to any of the
currently selected graphics. Use To-From Clipboard exactly as you would To-
From MacPaint files.

Note: Text can be treated as a graphic, using the procedures for
converting text to graphics outlined in Section 8, Special Features.
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Finished Selecting Graphics?

GRAPHIC LAYOUT

GREETING CARDS & SIGNS

Project Panel

Active Selection Window

Currently Selected Graphics

Getting Started

Positioning Your Graphics

Want to add a different graphic?

20

Once you've selected your graphics, you can either select the Graphic
Editor to modify your graphics or go directly to Graphic Layout to position
your graphics in your project.

Select Graphic Layout when you are ready to place your selected
graphics in your design for cards, signs, and letterhead. You will then see the
Graphic Layout screen. If you are making a banner, you will add your graphics
on the Main Banner screen.
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The layout screen for Greeting Card and Sign is the same, except that for
a greeting card you can choose a graphic layout for both the inside and the
outside. If you are designing a greeting card, select which panel—front or
inside—you wish to work on first.

Then choose which size graphics you want to work with first. Click Small
or Large. Three of your selected graphics appear on the right.

One of the graphics appears in the Active Selection Window. It appears in
several sizes. You have a choice of five different sizes for small graphics and
two for large graphics.

The panel on which you will lay out your graphics appears at the left of the
screen.

Move your pointer to one of the different sized graphics in the Active
Selection Window. Press the mouse button and a Grabber hand will appear.
Drag the graphic to the panel and position it where you want.

You can move your graphic within the panel by dragging. You can also
drag more graphics—the same size, larger, or smaller—from the Active
Selection Window to place in your design.

To remove a graphic from your card, simply drag it off the panel.

+ Click another graphic. It will appear, in different sizes, in the Active
Selection Window. You can then drag the graphic you want onto the panel.



Want to add a Full Panel?

Switching Sizes and Panels

Some Special Effects

LETTERHEAD

« Click Full panel to see the full panel graphic you have selected
displayed on your project. To remove the graphic, click again to "turn off" Full
panel.

+ Click Small/Large to switch from one size set of graphics to another.
« Click Front/Inside to switch from one greeting card panel to another.

Note: Usually, you will select the small, large, and full panel graphics you
want to use in your project before you start to do your layout. But sometimes
you may get an inspiration while working on the layout and want to select
some different graphics from a MacPaint or graphics library file.

You can do this but you should remember that the changes may affect
your present layout. If you have begun your layout and added a heart, for
example, and if you then replace the heart with a graphic of a fish, the fish will
appear on your layout in place of the heart.

If you want to select new graphics after you've begun laying out your
design, try to replace ones you have not already used.

If you want a repeated pattern of images, select [ Tited | Or (_staggered J.

+ Click to see images repeated across and down the page.
« Click to see staggered images.

+ Click either button again and again to see all the different variations
possible using your currently selected graphics.

« Click to quickly clear your panel of images. Then you can begin
your layout again.

+ Click to cancel your last action.

+ Click to return to the Main Project screen without saving your
graphics layout.

+ Click when you are satisfied with your layout.
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GRAPHIC EDITOR

Active Selection Box

Editing Tools Scroll Bar

Pattern Scroll Bar

Graphic Editor Buttons

Editing Small/Large Graphics

To add the currently selected graphics to your letterhead, simply drag
your graphics and place them on the top or bottom of your page. You have a
choice of two different sizes for small graphics and one size for large graphics.

* Click L1ited ) [_staseered ] or Full panel at the top or the bottom to add
special graphics effects.

« Click the Design Line buttons on/off. You can either retain or erase one
or both of these two lines that delineate the top and bottom of the letterhead
areas. If you do not want a design line to be printed, make sure that the
button to the right of the line is turned off.

» Click to erase your graphic layout so you can begin again.

» Click to return to the Main Project screen without saving your
graphics layout.

« Click to cancel your last action
+ Click when you are satisfied with your layout.
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Editing Window

Currently Selected Graphics

You may edit any of your small or large graphics by selecting Graphic
Editor from the Graphics Menu.

Click Small or Large to choose which size group of graphics you wish to
edit. Three of your currently selected graphics appear at the right. One
appears in the Active Selection Box on the left and also in the Editing
Window. To choose another graphic to edit, simply click the graphic you want.

Small graphics will appear in full in the Editing Window. Large graphics will
appear in part. To edit a different part of a large graphic, use the scroll bar to
move the graphic in the Editing Window, or select the hand icon from the
editing tools. Use the hand to move the graphic around in the Editing
Window.

Note: If you wish to edit a full panel graphic, you can do so by moving the
graphic into a MacPaint file and using MacPaint. See page 19 for details on
Copying to MacPaint.



Flipping Your Graphic

Select Tools/Patterns

Your Editing Tools

+ Press and H to flip your graphic horizontally.
+ Press and V to flip your graphic vertically.

« Press and | to invert your graphic from black to white. Press again
to revert back.

You may select tools to use in editing your graphics and patterns for
painting or filling in areas.

The currently selected tool and pattern is surrounded by a small box.

+ To select another tool or pattern, click it. The box will appear around
your new selection.

+ Click on the left and right arrows to scroll through the bars and see all
your tool and pattern choices.

QL 4
Gles: I

Fattern

After selecting a tool, move your pointer into the Editing Window and
press the mouse button to activate the tool.

{"7 Lets you grab and move the graphic around so you can edit all parts
of it.

J  Lets you draw a thin line—black on white or white on black.
&7 Lets you erase parts of your graphic.

& Lets you fill an outlined area with the current pattern. (If an outline
has gaps or holes in it, the paint "leaks" through. Choose Undo from the Edit
Menu. Then fillin any holes in the outline.)

é Different-sized paint brushes let you paint with the currently selected
pattern.

Note: All the editing tools, except thed™ , will work the same in both the
Active Selection Box and the Editing Window.

The €™ moves the graphic around in the Editing Window. It also moves
the graphic in the Active Selection Box. However, any part of the graphic you
move outside the box will be cropped as soon as you release the mouse
button. By cropping a graphic in this way you can create a differentimage. If
you crop your graphic by mistake, select Undo to cancel your last action or
Revert to restore the original graphic.
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Graphic Editor Button

Using The Clipboard

SAVE GRAPHICS

As you edit the graphic in the Editing Window, your changes are
displayed in the Active Selection Box.

Before making a major change, you may want to make a copy of the
graphic for your Clipboard. This will save the graphic in the Active Selection
Box as is so you can keep it and paste it back later if you wish.

» Click to remove the graphic from the Active Selection Box and
Editing Window and place it on the Clipboard.

+ Click to add the graphic in the Active Selection Box to the
Clipboard.

» Click(reste] to paste the contents of the Clipboard into the Active
Selection Box and Editing Window.

« Click[cieer) when you want to clear the Editing Window. This will also
clear the Active Selection Box.

» ClickBew=rt) if you wish to restore your active selection to its original
form. The Revert button insures that you will never lose the original graphic
you had when you entered the Graphic Editor.

» Click(s=+ ] if you wish to save your edited graphic to one of your own
graphics library disks. The Save Graphics screen will appear and you can
make a new file or select a file in which to save your graphic. Click the graphic
and it will be added to your file.

+ Click to undo your last action.

» Click to return to the Main Project screen without recording any
of your changes.

» Click when you are satisfied with your editing.

You can use the Clipboard in a variety of ways to move graphics to and
from the Scrapbook. See Section 8, Special Features, for a detailed
explanation of some other uses of the Clipboard.
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Using Save Graphics

DELETE GRAPHICS

The Print Shop Graphics Collection

You can create your own graphics library files by using the Save Graphics
function. You may want to make a file of your favorite graphics or to combine
graphics from different disks in a new file. You can even make special subject
files to suit your personal needs.

« Select Save Graphics to start a new file or add to an old one.

« Click to set up a new file. A dialog box will appear, allowing
you to make your selections.

+ Click when you want to add a graphic to an existing file.
The currently selected graphics appear at the left. You can save any of the 4
small, 4 large, or full panel graphics by clicking on it.

To delete graphics from the files you create, open Delete Graphics.
Select the file from which you wish to delete a graphic and the size graphic
you wish to delete.

Scroll though the library of graphics and click any unwanted ones. The
graphics you click will move to the trash can on the screen.

Note: You cannot cancel a Delete Graphics command. Once graphics
are deleted, they cannot be restored. Therefore, be careful to select only
those graphics you really want to delete.

You can save and delete graphics to and from any new library file you
create. But you cannot save or delete graphics to or from The Print Shop
Graphics collection. If you try to add or delete graphics to or from that file, a
dialog box will appear instructing you to select another graphic file. This
preserves the original graphic library and prevents deleting any of the original
graphics by mistake.
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GREETING CARD and SIGN

26

READY-MADE

With The Print Shop, you'll be able to create the perfect card to send for
any occasion and make a sign everyone is sure to notice. Signs and Greeting
Cards are designed in much the same way. The only difference is that to
make a Greeting Card you design two panels—front and inside. To make a
Sign, you design just one. With both Greeting Cards and Signs, you can
choose from a wide variety of graphics, borders, and fonts, as well as edit or
create your own graphics, or select ready-made projects for quick results.

Congratulations

Graduate!

e

To make a Greeting Card, click on the Greeting Card icon on the Project
Selections screen or open Greeting Card from the Selections Menu. The
Main Greeting Card screen will appear. You can now decide if you wish to
make a ready-made card or to create your own design.

The Print Shop's ready-made projects are designed to give you as much
freedom as you want. You can pick a card and print it without making any
changes. Or you can select a ready-made card and use it as a base for
designing your own card. You can start with a ready-made card and add text,
change borders, select different graphics, etc. The choice of what changes
to make is yours.

» Click(_Ready-nade ] to select one of the ready-made cards in the program.

A dialog box appears and you can select one of the ready-made card files
on your Print Shop Graphics disk. If you select Birthday, for example, the front
and inside panels of a birthday card will appear.

+ Click Choose to select another card from the listing.

» Click(C=Z) if you wish to select the ready-made card on the screen. If
you want to print your card now, turn to Section 7 for details on printing. If you
want to change the ready-made design, read on to see how you can create
your own designs.

+ Click if you want to return to the Main Greeting Card screen
without making a ready-made selection. Note: If you select
while you are in the midst of designing a greeting card and
then change your mind and select (canc=1 ], you will be returned to the
project you were working on, rather than to the Main Greeting
Card screen. To return to the Main Greeting Card screen, in
this case, select (o).




DESIGN YOUR OWN

FRONT/INSIDE

The Scroll Bar

BORDERS

Border Window

Active Selection Box

You don't need to start with a ready-made card. You can design your own

card entirely from scratch.

You can pick borders, select graphics, choose different typefaces,
compose your own messages, and personalize your card in just about any
way you want.

Because the program is so flexible, you can begin wherever you wish.
You may find that you begin by choosing a border first for one card and a
graphic first for another.

Generally, it's best to begin by choosing the most important or
predominant element. For example, if you want an elaborate border on the
front of your card, pick the border first and then type in your message. If the
message is more important, you may want to choose a font first.

Itis, however, a good idea to select and edit your graphics before you
begin laying out your design.

You can design two panels for your card—a front and an inside panel. To

work on a panel, click the appropriate button. These buttons will appear
throughout the Greeting Card program. By using them, you will be able to
switch easily from one panel to the other, so that you can coordinate the
borders, graphics, and fonts that you use.

Most of the greeting card panel you are designing can be seen in the
window. However, a small portion is hidden from view. To see the entire
panel, use the scroll bar.

Click to change the border on your front or inside panel.

& File Edit Selections Graphics Fonts FontSize

You will see the border currently selected for your panel in the Active
Selection Box.

Use the scroll bar at the bottom of the Border Window to scroll through
the entire border collection.

Select a border by clicking on it. Your new choice will appear in the Active

Selection Box.
Click to return to your original border selection.
When you are pleased with your border selection(s), click .
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TEXT

Making Font and Typestyle
Selections

Typing Your Message

Changing Font and Typestyle

You can type a message for your Greeting Card and decide how you want
it to appear. You can choose a font, a typestyle, line spacing and alignment of
text. Once your message is typed, you can change any part of your text
quickly and easily.

» Open the Font Menu. A check appears next to the currently selected
font. You can change the font by clicking another.

» Open the FontSize Menu. The menu lists different available point-sizes
for the currently selected font. Because some fonts look better in certain
sizes than others, recommended sizes for a chosen font are outlined.
Selecting one of the outlined sizes will give you the best results.

Click the boxes on the Greeting Card screen to:
« Select the style of your type—bold, underline, etc.
+ Select the spacing between lines.

« Select the alignment of the text—left, center or right.

A flashing cursor appears on the top of your card. The cursor marks the
spot where you can type your message. You can move the cursor by
pressing Return or Backspace or by selecting a different type alignment from
the boxes on your screen.

 Tostartanew line, press Return.
» Tomove up a line, press Backspace.

» To erase, move the cursor to the right of the letter or word to be erased
and press Backspace. Or, if you prefer, highlight the text to be erased and
press Backspace. (To highlight, position your cursor to the left of the first
word to be erased. Drag the cursor across the text; the text will appear
highlighted in black. Highlight all the text you want to erase and release the
mouse button. Then press Backspace.)

» Toundo your last typing action, select Undo from the Edit Menu before
doing anything else.

You may need to try different fonts and typestyles to get just the right
look for your card. You may also want to use several different fonts and styles
within the same message. Changing your type selections is easy.

» Tochange the font or style of the next word you type, simply make your
type selections and then continue typing.

» Tochange the font or typestyle of a previously typed word or phrase,
highlight the word or words you want to change. When all the text you want to
change is highlighted, release the mouse button. Now make your type
choices. When you are satisfied, click to remove the highlight.

Note: If you make a mistake and erase any or all of your text,
go the the Edit Menu and select Undo before doing anything
else. Your erased text will reappear.



GRAPHICS

PREVIEWING

A Credit Line For Your Cards

SAVING

You can add graphics to your card using the Graphics Menu. For
instructions on how to use the Graphics Menu, see Section 3. By reading this
section you will learn about all of The Print Shop's graphic possibilities. You
will find out how you can select graphics from various graphics files, including
your own MacPaint files, and how you can edit your graphics and lay them out
on your project.

Note that when you add graphics to your layout, you do not have to worry
about covering up your text. Any text that overlaps a graphic will be "masked”
so the type will still be readable.

Note: Sometimes when you are adding type to the Main Project screen
or graphics in Graphic Layout, you may want to remove your border. Pressing
and N will remove the current border on the panel you are designing.

L

After you've chosen the various elements—borders, type and
graphics—you can preview your whole card. Select Preview from the
Selections Menu to see the front and inside panels you've designed. If
something doesn't please you, you can go back and make whatever changes
you wish.

Add a personal touch with your own credit line. Click Creditto type in a
one line credit (Made by me and my Macintosh, for example) that will appear
on the back of your card.

Whenever you want to save your project to a file, select Save As... from
the File Menu. A dialog box will appear. You can then insert a data disk, name
your project, and save it. It is recommended that you save your files to a
separate data disk and not to either of the Print Shop disks. Once a project
has been saved, it will appear on the desktop with an appropriate project file
icon.

Select Save whenever you want to save design changes to your project
file.
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PRINTING

Ready To Start Again?

MAKING SIGNS

When you're ready to print your card, turn to Section 7, Printing Your
Project, for full details.

Note that checking your paper alignment is very important when making a
Greeting Card. If the paper is not positioned properly, your card will not be
correctly centered on the page when you fold it. Select Adjust Printer from
the File Menu to check your paper alignment. The printing test will print four
corners. Adjust your paper position and repeat the test until the corners
appear correctly centered.

When your entire card is printed (half upside down, half right-side up in
alternate corners), remove it from the printer and fold it in quarters. Your
finished card will have your design on the front and the inside, and an
optional credit line on the back.

Note: Special layout features are available for Greeting Card. For more
information, see Section 8, Special Features.
To design a new card, select New from the File Menu.

To design a different project, select Banner, Sign, or Letterhead from the
Selections Menu.

Making a sign is like making one large panel of a greeting card. Your sign
will print on one full side of an 81/2x11 inch sheet of paper. Your borders, text
and graphics will appear larger than on the smaller greeting card panels.

You select borders, graphics, and type styles for your sign the same way
you select them for a greeting card.

& File Edit Selections Graphics Fonts FontSize
Untitler=——————————

Sign

([ Borders | [ Ready-made |

X Pigin

[[] Boid [ ekl ine
1234 MAGNOLIA LN. O starse Clthabe
LWWESTBRA, CA 95957 Spacing Al ignment
=] 3
= (3]
=




READY-MADE

LETTERHEAD

With The Print Shop you can design your own stationery and letterhead.
You can choose a ready-made design and either printitasis oruseitasa
template, changing it in any way you want. Or you can start from scratch and
create your own unique design. You'll find it easy to make stylish letterhead
for all your business needs, as well as personal stationery that reflects your
interests and personality.

Your letterhead can have pictures and/or text at the top, the bottom or
both areas of the page.

@ GLOBAL TRAVEL

@ [ake [reation’ @

1573 Futars! Biwg.
Northesia, WJ. 0767
01) Sa5-7EES

Mary Andrews
255 Orand Street
Mission, Ca. 99930

If you'd like to choose a ready-made design, click(CReady-mese ]. You can then

select, from a dialog box, a number of different ready-made letterhead
designs. Open the design you wish to see.

31



32

DESIGN YOUR OWN
TEXT

Changing Font or Style

GRAPHICS

+ Click Choose if you want to return to the dialog box listing, and select a
different letterhead design.

« Click if you want to select the ready-made design on the
screen. If you wish, you can print your letterhead without making any
changes. (See Section 7 for printing details.) Or, you can add whatever
elements you wish: your name, address, slogan, new graphics, etc., before
you print.

If you want to work on your text message first, select the area — top or
bottom — in which you want your text to appear.

Position your cursor at the place you want to start your text. You can
position the cursor either by clicking one of the alignment boxes — left,
center, right — or by using the keyboard.

To move the cursor down a line, press Return. To move up, press
Backspace. To move right on the same line, press the space bar. To move left
on the same line, press Backspace.

Then select your typeface and size from the Fonts and FontSize Menus.
Select your typestyle by clicking the typestyle boxes on the screen.

Once you've made your text selections, you are ready to type your name,
address, or whatever message you wish. To start a new line, press Return.
Press Backspace to delete.

You may want to change your type selection or use a combination of
selections in the same letterhead. Changing your type selections is easy. To
change the font or style of the next word you type, simply make your
selections and then continue typing.

To change the font or typestyle of a previously typed word or phrase,
highlight the word or words you want to change. Make your new type
selections; then click your mouse to remove the highlight.

Note: If you make a mistake and erase any or all of your text,
go to the Edit Menu immediately and select Undo.

For a complete discussion of creating and editing text with the Macintosh,
see page 5.

When you've finished designing the text for one part of your letterhead,
select Top or Bottom to design text for the other part.

You may select and lay out your graphics at any time while designing your
letterhead.

You can select graphics from The Print Shop Graphics collection, or from
any MacPaint file, and edit them by making selections from the Graphics
Menu. See Section 3 on the Graphics Menu for detailed instructions.



GRAPHIC LAYOUT SCREEN

Top Design Area i

Design Lines

This arearemains empty — |

Bottom Design Area

Full Panel

Design Lines

When designing a letterhead you may choose 4 large and 4 small
graphics. In addition, you may select two horizontal full panel graphics —
one for the top, and one for the bottom of your letterhead. Once you have

chosen and/or edited your graphics, select Graphic Layout from the Graphics

Menu.
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Your Currently Selected Graphics

To add a graphic to your design, simply drag any one of your currently
selected graphics to the top or bottom of your letterhead. To remove a
graphic, drag it off your letterhead. You have a choice of two different sizes
for small graphics and one size for large graphics.

You can add as many graphics as you like. You can even add a graphic

behind type.

Graphic Layout Screen:

Main Editing Screen:
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Click the Full panel button next to the Top or Bottom Letterhead area to
either reveal or hide the panel you have selected for that area.

Two lines appear on the screen separating the top and bottom of the

Letterhead areas. If you want to erase one or both, simply click the button to

the right of the line. Click again to reactivate the line.
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Tiled/Staggered

SAVING

PREVIEWING

PRINTING

Ready to Start Again?

If you would like to see a repeated pattern across the top or bottom panel,
click(Tiled ] or [(_stageered | . Keep clicking to see various combinations until
you find one you like.
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« Click[ci==-] to erase all graphics on the page.
* Click (=2 ] to undo your last action.

+ Click to return to the Main Letterhead screen without saving any
changes.

. Click when you are satisfied with your layout.

You can save your letterhead design at any time by choosing Save As...
from the File Menu. A dialog box will ask you to name your letterhead file and
insert a data disk. Once your design is named and saved, you can continue to
work on it. As you complete different stages of your design, you can update
your file by selecting Save from the File Menu. Your saved letterhead will
appear on the desktop with an appropriate project file icon.

You may want to preview your letterhead design before you print. To do
this select Preview from the Selections Menu. Check to see that you've
removed any preset messages from the top or bottom of your screen, and
any border lines that you do not wish to appear. If you want to make any
changes, return to the Main Letterhead screen or the Graphic Layout screen.

If you are satisfied with your design and are ready to print, turn to Section
7, Printing Your Project.

Note: For information on how to copy your letterhead design to a
MacWrite document, see Section 8, Special Features.

To design a new letterhead after printing, select New from the File Menu.

To design a different project, choose Greeting Card, Sign, or Banner
from the Selections Menu.



READY-MADE

DESIGN YOUR OWN

GRAPHICS

BANNER

Make a banner to wish a friend a great day.
Happy birthday, Larry!

Or one to congratulate the whole team.

{Congratula_ltions, Chris, Ann, Susan, & Jo!}

Change the type to suit your whim. Choose different paint brushes for
different effects.

Bou've great, Mate

Yoy're great,Mate

And add a few pictures to give a lift to someone's spirits.

Y
i WV

Get Well Soon!

Using The Print Shop, you can make any day a banner one!

You can selecta readi-made banner to print as is or to modify to suit your
own needs. Click to see a listing of the available banners. Select

one from the dialog box. If you would like to see the listing again, Click
Choose. Click if you want to use the banner on the screen.

If you want to print your banner as is, refer to Section 7, Printing Your
Project.

If you'd like to make changes in the ready-made banner, read on to see
how you can add elements of your own.

You create your banner in the long narrow Banner Window.

As your banner gets longer, it will automatically scroll to the left; not all of it
will appear at once. Use the scroll bar to move from one part of your banner to
another.

You can add graphics to your banner from either the small or large size
graphics. Click either Small or Large to switch sizes. Note: Small and
large size graphics will appear the same size when printed on
your banner.
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TEXT

Using The Pixel Editor

Sample Letter with Current Shape and Pattern

Brush Shapes

Current Pattern

36

To add a graphic, simply drag one of the currently selected graphics to
the place where you want it to appear in the Banner Window. You can also
use the keyboard to add graphics. Simply type the keys which appear under
the graphic you want. The graphic will appear at the cursor location. This is
handy when you want graphics to appear in the middle of a message, or even
the middle of a word, you are typing. For a complete discussion of selecting
and editing graphics see Section 3, The Graphics Menu. Note: Text and
graphics are added on the Main Banner screen, rather than on a special
graphic layout screen.

The cursor marks the place where you can add text. If you want to add
text at a different place, simply move the cursor by using the mouse or
pressing the space bar.

Type the message you want on your banner. You can change the font,
fontsize and/or typestyles any time you want. All of the text on the banner will
be changed automatically to reflect your new choices.

Note: With banners you cannot use different fonts or styles
for different parts of your message as you can in other Print
Shop projects. When you make a font or typestyle change,

your entire text will change automatically. Italic is not available
with banners.

Pixel Editor, a special feature available only in Banner, lets you change
the pattern and brush shape used in whatever typeface you select.

Since your banner messages are printed in large type, changing the
shape and pattern of the individual pixels that form the letters can change the
whole look of your message. You can soften the type with a pale pattern or
create a zany look with a different pixel shape. Experiment with this feature to
create your own unique effects.

Note: Pixel Editor is best used with typefaces that are no
more than 36 point in size. If you select a larger face, the pixels
will have to be halved. This generally reduces the legibility of
the pixel shape. If you want a larger sized type, you may prefer
to use the preset pixel brush shape.

| & File Edit Selections Graphics Fonts FontSize

Banner Text Options

O |
®S®9
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Brush Patterns Brush Shape Box



PREVIEWING

Not satisfied with your Banner?

SAVING

PRINTING

Ready To Start Again?

Select a new brush shape by clicking one of the brush shapes. The
newly chosen shape will appear in the Brush Shape Box.

Select a new pattern by clicking one of the brush patterns. This pattern
will become the Current Pattern and will be surrounded by a moving dotted
line. The sample letter will change showing your new choices.

+ Click to cancel all choices and return to the Main Banner screen.

. Click when you are satisfied with your choices.

Your banner can be very short or very long; the size is up to you. To
preview your entire banner before or after finishing, select Preview from the
Selections Menu.

" & File Edit JOIIIISICTTN Graphics Fonts FontSize

Banner Preview

2 ,’, We wish pou a Mevey Christmas

2% and a Tappy New Pear  Je Je e Je

Press Backspace to delete letters and graphics one by one to the left
of the cursor. Or drag an unwanted graphic from the Banner Window to
remove it.

To clear text and graphics from the entire banner, select Clear from
the Edit Menu. To start from scratch, select New from the File Menu.

To save your banner, select Save As... from the File Menu. A dialog box
will appear. You can then insert a data disk, name your banner, and save it.
Once your banner is named and saved you can continue to work on it.

Select Save whenever you want to save design changes to your banner.
Your saved banner file will appear on the desktop with an appropriate project
file icon.

When you're ready to print your banner, turn to Section 7, Printing Your
Project, for full details.

To design a new banner, select New from the File Menu.

To design a different project, select Greeting Card, Sign or Letterhead
from the Selections Menu.
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PRINTING YOUR PROJECT

When you are ready to print your project, open the File Menu. The
printing commands are:

Select Colors

Print Options (Explained in Section 8, Special Features.)
Adjust Printing

Print Greeting Card, etc.

SELECT COLORS If you have an ImageWriter Il or Scribe printer, you can print your Print
Shop project in color with a color ribbon. To print in color, first complete the
design of your project, then choose Select Colors from the File Menu.

Select Colors

a—

{®) Front () Inside

@ Text {:} Graphics
Cl Borders {:} Background

@Black* DPur*ple O'-r'ellow*
O Orange O Green O Red#*

() Blue* * indicates primary color

Comee ) C o]

You can choose to print your text in one color, your borders in another,
and your graphics in a third.

« If you are making a greeting card, first choose your panel, either Front
or Inside.

« If you are making letterhead, choose Top or Bottom.

+ Then click the button next to the element — Text, Borders,
Background or Graphics — you want to print in color. Click a color choice.
Repeat this step until you have chosen colors for each design element.

+ When you are finished, cIick.



ADJUST PRINTING

PRINTING

LASERWRITER HINTS

The Adjust Printing test lets you check the alignment of your paper. This is
important because if your paper is not aligned properly, your project will not be
correctly positioned on the page. To perform the paper alignment test:

+ Make sure your printer is properly connected to your computer, power
on and selected.

» Select Adjust Printing. Four corners will be printed on the sheet of paper.
If the corners are centered top and bottom on the page, your paper is properly
aligned. If they are not centered, re-position the paper and try again.

When you are ready to print, select Print... from the File Menu. Make sure
that your printer is turned on and properly connected. If you are printing on an
ImageWriter | or |I, the computer will set the printing configuration for you.
Otherwise, you can make your choices from the dialog boxes which will appear
automatically.

To see more print options, hold down the Option key while selecting Print
from the File menu. But a word of caution. Using any of these options may
inadvertantly affect the placement on the page of the project you are printing,
and give you less than satisfactory results.

When your project has finished printing, you can make another copy if you
wish by selecting Print... again.

Because the LaserWriter is unable to print as close to the edge of the
paper as an ImageWriter, your greeting cards may not be precisely centered
when you fold them. To compensate for this, you can trim the sides to make
the border even.

Since the LaserWriter prints on individual sheets, when making a banner
you will have to tape the pages together. You should be aware that, since
the LaserWriter is unable to print as close to the edge of the paper, a por-
tion of your text and graphic at the top and bottom of your banner will
not print.
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SPECIAL FEATURES

ADDING NEW FONTS

COPYING A LETTERHEAD
DESIGN TO A MACWRITE
DOCUMENT

USING TEXT AS A GRAPHIC

40

The Print Shop is made so that you can design and print out a project
quickly and easily. Some features are preset to simplify your choices. There
are also some special features that you can use to change your layout and
create special effects in your projects. Experiment with these features to see
what works best for you.

You can create your own font file for use with The Print Shop program. To
do this, you will need the Font/DA Mover™ program available on the System
Update disk which your Apple dealer can provide.

When using Font/DA Mover:
1. Create a separate file with Font Mover.
2. Add your fonts to the file.

3. Add the font file name to Preferences, located on the File Menu, so
that The Print Shop will know where to find the fonts.

Note: Deleting fonts from your Print Shop Fonts file is not
recommended because you run the risk, once you have done
so, of discovering that you cannot recreate a saved project or
use a ready-made design that uses the fonts you have deleted.
If you have deleted fonts that are used in a Print Shop project,
and you want to use that project again, a dialog box will appear
stating that new fonts must be substituted for the deleted
ones.

Complete your letterhead design. Then select the To-From Clipboard
option from the Graphics Menu and press A. Your complete design,
including text and graphics, will be copied to the Clipboard. Load MacWrite,
set the desired margins, and paste your letterhead design from the Clipboard
into your MacWrite document.

Note: MacWrite will not be able to accommodate the full width of the
letterhead so it will shrink the design slightly to fit.

If you want to create a graphic composed of text for use in your Print
Shop creations, follow these steps:

1. Startin any of the Main Project screens.
2. Type your text.

Note: The only font that can be used as a graphic is
Chicago.

3. Highlight the text you typed.
4. Select Copy from the Edit Menu to copy this text to the Clipboard.
5. Select To-From Clipboard from the Graphics Menu.

6. Click(:=cev:-] and the text in the Clipboard will be copied to the current
graphic selection.



SPECIAL PRINT OPTIONS

GREETING CARDS

Printing on Four Panels

You can now edit, modify, save, or use this text just as you would any
other graphic. Note: This type of text-graphic can be especially effective
when used in banners.

Before you print your greeting card, you can select Print Options from the
File Menu to make some special layout choices. A dialog box will appear with
four layout boxes in it.

Greeting Card Print Options

<-- Inside -->
<-Front Back->

<-- Inside
<-- Front

(Cancer ) o ]

A black line surrounds the first box. This is the preset layout for greeting
cards. The inside panel appears on the top left. The front panel appears on
the bottom right.

By clicking one of the other boxes, you can change how your card will
print. The black line will surround your new choice.

For example, if you click E your inside panel will appear on the top
right—and actually be printed on the left inside panel of your card. The front
panel you design will be printed on the back of your card.

You might want to design and print a card on all four panels. To do this:

1. Design the front and inside panels. Check your paper alignment and
print as usual. Then roll your printed pﬁﬁr back to its original position.

2. Design two more panels. Click and print. Your panels will appear
on the inside left and back of the card you have already printed. If you want
designs on three panels, simply leave one panel blank.

Click the other two Print Option choices when you want to stretch out

one or both panels. To have an inside panel that stretches to cover both
inside panels of your card, click .
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Your design will look like this:
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If you click E , both panels will be stretched. However, since you are
printing on only one side of the paper, both panels will be on the outside or
inside of your card. You might want to use this layout for a large placecard with
designs on the front and back.
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To print on the other side of the sheet of paper, remove the paper from
your printer and turn it over before re-inserting.

Experiment with these layouts to see what kind of interesting and
unusual projects you can create.



BANNERS

Grid or Solid Graphics

Two Lines of Text

Banners generally consist of one line of full size text and graphics printed
solid like this:

% Happy Day, Mom! %

By selecting Print Options before you print, you will have a choice of
some advanced layout options.

You can choose to have your graphic printed in a grid pattern instead of
the usual solid. Grid adds a bit of space between each pixel. It gives your

graphic a distinctive look .
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o print your message in two lines.

For example:

A\
=T

1  HAPPY ANNIVERSARY

EAYMOND AND DOROTRHY!

43



PRE-LOADING FONTS,
BORDERS, AND GRAPHICS

In order to make a banner like this you must print in three steps. You may
need to experiment with choices and paper alignment to get this just right.
Whenever you print a project in several steps, it is a good idea to note where
the edge of your paper is in your printer. Since you will have to roll back the
paper and print again, it helps if you know exactly where you started.

1. Select the butterfly graphic and print as usual. With a pencil, lightly
mark your paper by the roller shaft.

2. Drag the butterfly graphic off your banner window. Type in "Happy
Anniversary." Select Print Options from the File Menu and choose Top Half.
Select Print and your message will print right after your graphic.

3. Clear your banner of text, and roll your paper back so that your roller
shaft lines up with the pencil mark you made. Type in your message for the
bottom line. Select Print Options again but this time choose Bottom Half.
Then select Print.

Experiment to find new ways to use this feature. For example:

* You can add small graphics on the top and bottom line.
» You can stagger text and graphics on the two lines.

* You can use the Pixel Editor to change the patterns of one or both
lines. You can also change the brush shape of one or both lines. But
remember that certain brush shapes may be less legible in the smaller
typestyles used in this option.

If you are using a one-drive system and want to reduce the amount of disk
swapping you will do, you can pre-load The Print Shop's fonts, borders, and
graphics. When you do this, the program will not have to access The Print
Shop 2 disk as often to find the design elements you want to use.

To pre-load, select Preferences from the File Menu. A dialog box will
appear. Click the elements—fonts, borders, or graphics—you want to pre-
load. You may also type in the name of any other font file you want to use.
When you are finished, click o« _J.

The next time you load the program, The Print Shop will pre-load the
elements you selected in Preferences. Note that while time-consuming disk
swapping will be reduced, loading will take considerably longer.

If you added your own font file, it will be pre-loaded along with The Print
Shop fonts and will appear on the Font Menu.

Note that if, during operation of The Print Shop, the memory that the pre-
loaded files use is needed, the files will be purged. The Print Shop will reload
files as they are needed.



MENUS AT A GLANCE
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1 (3 File Edit Selections Graphics Fonts FontSize W
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m Selections
About The Print Shop... New Unio vSign Select Graphics... %6 | |/Athens
Open... Banner To-From Macpaint™ file... ¥M Avant Garde
Alarm Clock Close Cut xH Letterhead To-From Clipboard... Cairo
Chooser Revert Copy =C Greeting Card Chicago
Control Panel Save Peste el Graphic Layout... %L | | Courier
Key Caps save fs... Clear Ereview.. Graphic Editor... ®E | | Geneva
scrapbook Preferences... Selectin' %A Helvetica
Select Colors... . Save Graphics... London
Print Bplioas e Chphoerd Delete l?r‘:mhits‘.. :; Los Angeles
Adjust printer... Monaco
Print Sign... New York
San Francisco
Quit Seattle
Times
Toronto
Uenice
Zapf Chancery

ADDITIONAL KEYBOARD

SHORTCUTS
GRAPHIC EDITOR linverts the graphic.
V flips the graphic vertically.
H flips the graphic horizontally.
MISCELLANEOUS A copies a complete panel to either a MacPaint file or to the
Clipboard.

N switches to no border from the main Greeting Card or Sign
screens, or while in the Graphic Layout section.
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10.

ADDITIONAL EXAMPLES
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BANNERS
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